
¿QUÉ ES UN PIC?
Los circuitos integrados programables (Program-

mable Integrated Circuits = PIC) son componentes su-
mamente útiles en la Electrónica de Consumo. Aún cuan-
do son conocidos desde hace más de veinte años, exis-
ten en la actualidad nuevos tipos que cumplen con una
serie de requisitos y características sumamente útiles.
Como una primera aproximación podemos definir a un
PIC como “un chip que me permite obtener un circuito in-
tegrado a mi medida”, es decir puedo hacer que el PIC se
comporte como un procesador de luminancia o un tempo-
rizador o cualquier otro sistema mediante un programa
que le grabo en una memoria ROM interna.

Los microcontroladores PIC son en el fondo procesa-
dores similares a otros tipos, como por ejemplo la familia
de los microprocesadores X86, 80486, Pentium y muchos
otros que usan una arquitectura interna del tipo Von Neu-
mann. En este tipo de arquitectura los datos y la memo-
ria del programa se encuentran en el mismo espacio de
direcciones.

En realidad un microprocesador y un microcon-
trolador no son la misma cosa. Los PICs son micro-
controladores, es decir, una unidad que posee en su
interior al microprocesador y a los elementos indis-
pensables para que pueda funcionar como una mini-
computadora en un solo chip.

Un microprocesador es solamente la unidad central
de procesos o CPU, la memoria, los puertos y todos los
demás periféricos son exteriores. La programación de un
microprocesador es, por lo tanto, una tarea compleja por-
que deben controlarse todos estos dispositivos externos.

Un microcontrolador integra la CPU y todos los peri-
féricos en un mismo chip. El programador se desentiende

de una gran cantidad de dispositivos y se concentra en el
programa de trabajo. Esta circunstancia da lugar a una
gran pérdida de tiempo porque los datos tienen que ser
retirados de la memoria y llevados a la CPU (Central Pro-
cessor Unit) y viceversa. Esto significa que la computado-
ra dedica la mayor parte del tiempo al transporte de da-
tos de ida o de vuelta, en lugar de usar este tiempo para
trabajar sobre los datos.

Los PICs emplean un conjunto de instrucciones del ti-
po RISC (Reduced Instruction Set Computer). Con el
RISC se suele ejecutar la mayoría de las instrucciones
con un solo pulso del clock. Con las instrucciones que se
usan en otros equipos del tipo CISC (Complex Instruction
Set Computer), se logran instrucciones más poderosas,
pero a costa de varios ciclos del clock. En el bien conoci-
do procesador 68HC11 de Motorola se requieren a veces
hasta 5 ciclos del clock para ejecutar una instrucción.

A los fines prácticos nos vamos a referir a los micro-
controladores como bloques que poseen una memoria de
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programa que es el lugar donde deben alojarse los datos
que le indiquen al chip qué es lo que debe hacer; una me-
moria de datos donde ingresen las señales que debe pro-
cesar el programa, una unida aritmética y lógica donde se
desarrollen todas las tareas, una unidad de control que se
encargue de supervisar todos los procesos y puertos de
entrada y salida para que el PIC tenga contacto con el ex-
terior (figura 1).

Un microcontrolador como cualquier circuito integra-
do analógico tiene entradas, salidas y algunos compo-
nentes exteriores necesarios para procesar las señales
de entrada y convertirlas en las señales de salida (figura
2). El 16F84 requiere un cristal con dos capacitores y co-
mo mínimo un resistor para el reset. Por supuesto nece-
sita una tensión de fuente de 5V (VDD) aplicada con res-
pecto al terminal de masa (VSS). Posee dos puertos de
salida, el A y el B, cuyos terminales son marcados RA0 al

RA4 y RB0 al RB7. Estos puertos pueden ser programa-
dos como de entrada o de salida. El terminal 4 opera co-
mo reset pero también cumple funciones de carga de me-
moria de programa cuando es excitado con pulsos de
15V. El terminal RA4 (pata 3) también tiene funciones co-
mo entrada de un temporizador y RBO (pata 6) cumple
también funciones como entrada de interrupción.

Ahora bien, la mayoría de los microcontroladores
(sean de Microchip, o de National, Motorola, Philips, etc.)
se comportan de forma similar, por ello nos vamos a re-
ferir a los microcontroladores PIC16F84 cuya arquitectu-
ra interna puede observarse en la figura 3.

Observe primero los bloques externos. Existe un cris-
tal que se conecta en OSC1 y OSC2 para generar el
CLOCK del sistema. Luego una señal de entrada llamada
MCLR negada, que es un nombre de fantasía para nues-
tro conocido RESET (debido a que esa pata tiene un do-
ble uso) y, por último, dos puertos paralelos de I/O (entra-
da o salida) llamados puerto A y puerto B. Una de las pa-
tas del puerto A puede ser utilizada como entrada de in-
terrupciones (esta pata especial hace que el microproce-
sador deje de realizar la tarea que estaba ejecutando y
pase a realizar otra tarea alternativa; cuando la termina
vuelve a su programa original).

Analicemos el bloque más grande (temporizadores),
en éste observamos un grupo de bloques dedicados a
mejorar el funcionamiento pero sin influir directamente en
el flujo de señales. Vemos un temporizador de encendido,
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un temporizador de arranque del oscilador de CLOCK, un
circuito de reset y un circuito llamado de vigilancia o
WATCHDOG. Los dos primeros bloques procuran un
arranque ordenado para no producir una carga al mismo
tiempo sobre la fuente. Por último, existe un circuito con
un nombre curioso: “perro guardián”. Su función es estar
vigilante el máximo de tiempo que tarda el microprocesa-
dor en completar su programa (o mejor sería decir, la de-
rivación más larga de su programa) y en caso de superar-
se ese tiempo, provocar un reset automático porque el
microprocesador se quedó trabado en alguna parte de su
programa. También se dice que el microprocesador se
quedó colgado o congelado.

Este bloque de circuitos no trabaja independiente-
mente sino que requiere conexiones al exterior y al inte-
rior del dispositivo. Por ejemplo, no siempre son utilizados
y es el programa quien determina su utilización y además
ajusta sus parámetros. Esto se realiza a través del bloque
de control o decodificador de instrucciones.

Analicemos ahora la sección de arriba a la izquierda
en donde observamos la memoria de programa, el conta-
dor de programa, el registro de instrucciones y la pila o
STACK de 8 niveles. Cuando hablamos de registros nos
referimos a pequeñas unidades de memoria transitoria,
construida por lo general con un registro de desplaza-
miento como los analizados en “el rey micro”. Son memo-
rias volátiles que se utilizan para guardar información por
un tiempo mínimo, con el fin de realizar una operación
compleja de varios pasos.

El contador de programa es el responsable de que el
microprocesador vaya analizando las instrucciones en or-
den ascendente. Este guarda el número de instrucción en
el STACK y la instrucción misma la pasa al registro de ins-
trucciones desde donde se envía al resto del microproce-
sador. El STACK es, en realidad, una pila de registros (en
nuestro ejemplo hay 8), debido a que el programa puede
tener derivaciones (en la jerga LOOPS, rulos o subpro-
gramas). Cuando se termina de ejecutar un loop se debe
volver al mismo punto del programa en donde se había
producido la bifurcación y eso es posible porque ese nú-
mero de instrucción quedó guardado en uno de los regis-
tros de la pila. Es común que un loop tenga, a su vez, un
loop secundario y cuando se ejecuta ese loop secundario
se debe volver al mismo punto del loop primario, eso se
consigue con guardar ese número  de instrucción del loop
secundario en otro registro de la pila.

Analicemos ahora la sección inferior derecha. En ese
sector se ubican los bloques responsables de efectuar
operaciones matemáticas y lógicas binarias; recordemos
que el nombre ALU proviene de Aritmetic Logic Unite

(unidad arimética y lógica). En este sector es imprescin-
dible utilizar un registro ya que una operación aritmética
o lógica siempre se efectúa entre dos números. Los nú-
meros binarios que deben procesarse se toman de la me-
moria de datos, el primero se acumula en el registro de
trabajo o registro W (de Work = trabajo) el segundo es el
presente en el instante en que se invoca la memoria de
datos. Como las operaciones pueden ser encadenadas
(cuando el resultado sirve como operando de la siguien-
te operación, tal como el caso de un producto) el registro
W tiene un retorno a la ALU.

Vemos además que la ALU está comandada por el
bloque MUX (MUltipleXador). En efecto, la ALU requiere
que se le envíen números para procesar que le lleguen
desde la memoria de datos, pero antes se la debe predis-
poner para que efectúe la operación requerida (compara-
ción, rotación de dígitos, etc.).

El registro de estado o estatus colabora durante las
operaciones matemáticas. Piense cómo opera Ud. para
realizar una resta: primero ubica el primer número, luego
el segundo y después comienza a analizar los bits menos
significativos (las unidades), pero si el número de arriba
es menor que el número de abajo, entonces toma presta-
do de la columna de las decenas, luego debe recordar es-
to porque el número de arriba en la columna de las dece-
nas se redujo en una unidad. En realidad, aunque se tra-
te de una operación entre dos números su ejecución re-
quiere guardar lo que se llama acarreo en otro registro y
éste no es otra cosa más que el registro STATUS.

El PIC16C84 contiene además de todo lo visto una
memoria RAM de registros que puede ser llamada desde
el registro de instrucción a través de un multiplexador de
direcciones. Esta sección sólo se utiliza en desarrollos
avanzados. Ahora bien, un microcontrolador sin programa
no sabe hacer nada, es como un niño recién nacido; tie-
ne algunos reflejos condicionados como el de succión
que le permite alimentarse pero no sabe hacer más que
eso. Nosotros deberemos enseñarle a realizar acciones y
lo vamos a hacer como a un bebé, paso a paso. Su capa-
cidad de aprendizaje es enorme y sumamente variada. Le
vamos a enseñar a llorar a intervalos regulares, a encen-
der luces, a sumar, a restar, etc.

Enseñarle significa programarlo y eso se realiza con
una plaqueta de programación que depende de cada
marca y modelo de microcontrolador. Antiguamente los
microprocesadores tenían una ventanita transparente y
era necesario exponerlos a la luz ultravioleta para borrar
su memoria e introducir un programa nuevo. Actualmente
cuentan con memorias que no tienen este requisito. Bas-
ta con cargarlos con un programa para que se borre el
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anterior. Esto significa que, con el mismo integrado, po-
dremos construir diferentes dispositivos que realicen fun-
ciones totalmente distintas unas de otras.

LA MEMORIA DE PROGRAMA

Es una memoria EEPROM, es decir, de lectura so-
lamente (ROM = Read Only Memory) que se programa
por tensión (no necesita luz ultravioleta); es decir que
basta con introducir los datos  con cierto nivel de tensión
para que éstos borren el programa anterior y graben
uno nuevo.

¿Por qué esta memoria se llama ROM, si se pueden
grabar datos sobre ella? 

Se llama ROM porque para grabarla se debe conec-
tar el PIC al programador; luego de que el PIC coloca es-
tos datos en la plaqueta del dispositivo, sólo pueden ser
leídos, ya que entonces forman el programa del PIC.

Esta memoria (figura 4) tiene una longitud de 1 Kbyte
con palabras de 14 bits. Digamos que tiene un ancho de
14 bits y una altura de 1.000 Bytes o que es una memo-
ria de 1.000 x 14. Observe que los números de instruc-
ción en hexadecimal van desde
el 000 al 3FF, lo cual implica
que existen 1.040 posiciones
de memoria, valor obtenido em-
pleando la fórmula:

3 x 162+16 x 161+16 x 160

Observe que dos de las po-
siciones de memoria tienen las
indicaciones “vector de reset” y
“vector de interrupción”.

Eso significa que, cuando
se provoca un reset, el micro-

procesador vuelve a la posi-
ción 000 del programa y cuan-
do se produce una interrup-
ción, a la posición 004. Estos
retornos forzados deben ser
considerados al diseñar el
programa del microprocesa-
dor; es decir que el reset se
produce porque la señal exter-
na pone el contador de pro-
grama en 000 y todo el progra-
ma se reinicia. En cambio,

cuando ingresa una señal por la pata de interrupción el
contador de programa va a 004 y la acción que, en gene-
ral ocurre, es que se comienza a leer un subprograma
particular. Cuando este subprograma termina, el contador
de programa recupera el número que tenía en el momen-
to de arribar la interrupción.

LA MEMORIA DE DATOS

La RAM (Random Acces Memory = memoria de ac-
ceso aleatorio, figura 5) es una memoria de lectura y es-
critura de 128 posiciones pero que sólo tiene implemen-
tados las primeras 48 posiciones (desde 00 a 2F en he-
xadecimal). De estos 48 registros, los primeros 12 son fi-
jos y cumplen un propósito determinado, en tanto que
desde el 13 hasta el 48 son registros de propósito gene-
ral, en donde el programa puede indicar que se almace-
ne un dato para ser tomado más tarde.

Los Puertos del PIC

El PIC16C84 tiene dos puertos paralelos de entrada
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o salida: el puerto “A” de 8 patas y el “B” de 5 patas. Ca-
da pata puede ser predispuesta por el programa para
operar como de entrada o de salida. Cada pata tiene un
resistor de pull-up (resistor conectado a fuente) interno
que puede ser desconectado mediante el programa. Es-
tos resistores se desconectan automáticamente si una
pata se predispone como pata de salida debido a que las
salidas ya tienen posibilidad de entregar corriente desde
fuente con un transistor.Todos los resistores de pull-up se
conectan o desconectan al mismo tiempo (no existe  un
comando que los conecte  independientemente).

Como puerto de salida, una pata puede tomar 25mA
del circuito o entregar 20mA al mismo, sin embargo, en el
puerto “A” sólo se pueden consumir 80mA en total o en-
tregar 50mA, esto significa que sólo algunas patas pue-
den trabajar al máximo porque si todas lo hicieran (y son
8) el consumo total sería de 25 x 8 = 200mA. El puerto “B”
tiene otras características máximas, ya que en total pue-
de tomar 150mA o entregar 100mA. Como vemos, las sa-
lidas admiten suficiente carga como para alimentar direc-
tamente a un led (figura 6).

Los puertos no utilizados siempre se deben conectar
a la fuente de 5V a través de un resistor de 10kΩ debido
a que se trata de un dispositivo CMOS que, de otro mo-
do, podría deteriorarse por captación electrostática (figu-
ra 7).

La pata 3 perteneciente al puerto “A”
puede ser configurada como de entrada-
/salida o como de arranque de un tempo-
rizador/contador (figura 8). Cuando se
programa como entrada esta pata fun-
ciona como un disparador de SCHMITT
o Schmitt trigger ideal para reconocer
señales distorsionadas o con crecimien-
to lento. Esta misma pata también tiene
una característica distinta cuando opera
como salida. Ella es la única que trabaja
a colector abierto, es decir, que no pue-
de emplearse como fuente, en este caso

siempre se utilizará un resistor externo.

EL CLOCK

Los PIC poseen un oscilador configurable por progra-
ma de características muy amplias. Cuando no se requie-
re mucha precisión se puede trabajar con un oscilador a
RC conectado según la figura 9.

Para circuitos que
requieran una gran
precisión se puede tra-
bajar con un cristal de
frecuencia baja, media
o alta (figura 10). Co-
mo máximo el
PIC16C84 puede tra-
bajar con un cristal de
10MHz. Internamente
la frecuencia del cristal
se divide por 4, por lo
tanto, es muy común la
utilización de un cristal de 4MHz para obtener un CLOCK
interno de 1MHz que garantiza que cada instrucción du-
re exactamente 1mS. Para temporizadores de período
largo se utilizan cristales de baja frecuencia.
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El Reset 

El PIC “se resetea” cuando la pata 4 (MCLR negada)
se pone a potencial bajo. Para simplificar el circuito de re-
set el PIC posee un temporizador interno que permite
realizar un reset automático cuando se aplica tensión de
5V. En estos casos el circuito externo de reset sólo impli-
ca el uso de un resistor de 10kΩ entre la pata 4 y fuente
tal como se muestra en la figura 11.

En muchos circuitos es necesario realizar un reset
manual y para ello
existen dos posi-
bilidades, una es
utilizar sólo el
temporizador in-
terno (por progra-
ma) y la otra es
agregar una cons-
tante de tiempo
exterior como se
muestra en la fi-
gura 12. En el se-
gundo circuito C1

provee un retardo al
encendido o posterior
al pulsado de reset
porque C1 se cargará
lentamente a través
de R1 con una cons-
tante de tiempo de
22kΩ x 10µF =
220mS.

El resistor R3 limi-
ta la corriente de
descarga de C1 a

valores compatibles con sus características de corriente
de pico máxima.

D1 descarga a C1 cuando la tensión de fuente decae
para permitir un reset inmediato cuando la fuente se apa-
ga y se enciende en rápida sucesión. R2 limita la corrien-
te de reset, tomada desde el microprocesador. Este se-
gundo sistema se suele utilizar cuando se requiere un re-
seteado remoto a través de varios metros de cable que
podrían captar zumbido (C1 reduce la impedancia del cir-
cuito de reset).
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Programas Cargadores de PICs
Hardware y Software para Cargar Microcontroladores

Tenga circuitos gratuitos para cargar programas en la memoria de un PIC.

INTRODUCCIÓN

Para que un PIC funcione como nosotros queremos
es preciso “cargarle” un programa en la “memoria de pro-
grama”. El programa debe estar en un lenguaje compren-
sible por el chip o sea un lenguaje de máquina en código

binario aunque en realidad al PIC debemos introducirle
un programa en código hexadecimal e internamente lo
convierte a binario para realizar su interpretación.

El programa que debemos cargarle al PIC en código
hexadecimal tiene que tener la terminación “hex”.

Sin embargo, normalmente se debe escribir “editar” el



programa en un lenguaje entendible por el usuario, nor-
malmente conocido como “assembler”. Los PIC basan su
programación en un set reducido de instrucciones que
permiten editar el programa generando un archivo con
extensión “asm”.

Existen programas que se encargan de “traducir” el
programa escrito en lenguaje assembler (asm) a progra-
ma escrito en lenguaje de máquina (hex); a estos progra-
mas se los denomina traductores o ensambladores.

Por lo tanto, para escribir un programa y cargarlo en
un PIC precisamos:

• Un utilitario o programa que nos permita escribir el
juego de sentencias a cargar en la memoria de programa
del PIC. Este utilitario es un “editor” y como ejemplo tene-
mos el MPLAB.

• Un utilitario o programa que nos permita “traducir” el
programa escrito en assembler a lenguaje de máquina
para que podamos cargarlo en el PIC. A ese programa se
lo denomina “ensamblador” y como ejemplo tenemos al
MPASM.

• Un utilitario para “cargar” el archivo que tiene el pro-
grama en lenguaje de máquina (archivo con extensión
hex) en la memoria del PIC. A estos programas se los de-
nomina “cargadores” y como ejemplo tenemos al NOPPP,
al PIC PRO y a tantos otros, muchos de los cuales men-
cionaremos más adelante.

Pero también existen otros utilitarios que permiten “si-
mular” y “emular” un programa para ver cómo se compor-
ta antes de cargarlo en el PIC.

El simulador permite detectar errores en el programa
(el MPLAB permite simular) para poder corregirlos. El
emulador permite que “una computadora se comporte co-
mo PIC” siendo las patas del puerto, las correspondientes
a las del PIC.

Esto quiere decir que si queremos hacer circuitos con
PICs, para poder predisponerlo adecuadamente precisa-
remos:

• Programa MPLAB: Para editar (escribir) un progra-
ma en lenguaje assembler y así generar el archivo con
extensión asm. El MPLAB también me permite “simular”
el funcionamiento del programa para detectar errores y
corregirlos.

• Programa MPASM: Para “ensamblar” o convertir el
archivo asm en archivo hex con el objeto de cargarlo en
el PIC.

• Programa NOPPP: O cualquier otro cargador que
permita ingresar el archivo con extensión hex en la me-

moria de programa del PIC. También se puede emplear
cualquier otro cargador, hasta iuncluso se podrían cargar
los datos manualmente, tal como veremos oportuname-
nte. Todos los programas cargadores precisarán de un
circuito “eléctrico” o hardware para poder realizar la fun-
ción de carga.

LOS CARGADORES DE PICS

Dijimos que un cargador de PIC debe poseer por un
lado el circuito que permita cargar el programa desde una
computadora (hardware) y el programa que permita ma-
nejar a dicho circuito para realizar la operación de carga
(software). El circuito debe ser muy simple.

Vamos a suponer que no tenemos un dispositivo pro-
gramador a nuestra disposición; es decir que deberemos
armar también un dispositivo programador de nuestros
PICs que se conecte al puerto paralelo de una PC (el
puerto de impresora).

Nuestra intención es que construya un dispositivo pa-
ra programar PIC que sea muy sencillo  de modo que se
pueda armar en el mismo protoboard y que se conectará
a la PC por intermedio de una manguera.

Como todos sabemos, un dispositivo para una PC
(hardware), siempre necesita un programa que lo contro-
le (software). Nuestra intención es que Ud. no compre na-
da más que lo imprescindible; así que vamos a usar un
software gratuito llamado NOPPP que puede bajarse por
Internet. Ud puede bajar este programa, el MPLAB, el
MPASM y otros programas y utilitarios, siguiendo los pa-
sos dados en la página de contenidos especiales de Sa-
ber Electrónica y, lo que es más importante, en forma to-
talmente GRATUITA.

Para ello diríjase a: www.webelectronica.com.ar (si
no tiene Internet o no sabe cómo se hace, lleve este es-
crito a cualquier cybercafé y pídale al encargado que le
baje los programas). Haga doble click sobre el ícono
password y luego digite la clave aiwa15.

Recuerde que cuando decimos “programar” nos esta-
mos refiriendo a diseñar un programa para un PIC y a la
persona que realizó ese trabajo la llamamos “programa-
dor”; cuando decimos “cargar” nos estaremos refiriendo a
llenar con datos la memoria de un PIC y el dispositivo que
realiza esta función lo llamaremos “cargador de PICs”.
Aunque parezca increíble nuestro amplio idioma no tiene
una palabra precisa que diferenciara a la acción del apa-
rato y se suscitaban graves confusiones al leer, por algo
tan simple. En realidad, sí estaba acuñado un término
práctico para el dispositivo: “quemador de PICs”, pero el
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mismo sólo se puede aplicar a aquellos PICs que sólo se
pueden grabar una sola vez. Por otro lado, el término se
puede confundir con un dispositivo que funcionando mal
quema a los PICs en lugar de cargarlos, tal como el au-
tor mencionará con respecto a un programador comer-
cial.

Navegando por Internet es posible encontrar gran
cantidad de programas cargadores de PICs, nosotros ha-
remos referencia a los cargadores:

* Cargador NOPPP
* Cargador PROPIC
* Cargador Universal de PICs y EEPROM
* Cargador PIC800
* Cargador PP84 

Obviamente, todos estos circuitos puede “bajarlos li-
bremente” pudiendo tener más información y los enlaces
a las páginas web de cada uno de estos cargadores en la
página de contenidos especiales que hemos dado ante-
riormente. Estos cargadores sirven para ser utilizados en
diferentes tipos de PICs a saber:

NOPPP es un programa de uso libre ampliamente di-
fundido que sirve para cargar PICs del tipo 16C84, 16F83
y 16F84, pero también se dán otros cargadores con sus
respectivos programas, que sirven para otros componen-
tes.

PICPRO es un programador avanzado en relación
con el NOPPP y sirve para ser montado cuando no se
quieren correr riesgos con la PC que se está utilizando
para cargar PICs y cuando se desea tener un trabajo li-
bre de errores (el NOPPP es un programa para aprendi-
zaje).

El Programador Universal sirve para programar:
12C508, 12C509, 12C67X, 16C55X, 16C61, 16C62X,
16C71, 16C71X, 16C8X, 16F8X, 16F873/4/6/7,
16C73/74/76/77. También programa memorias EEPROM
de la serie 24LCXX.

PIC800 es un programador para 16C84, 16F84,
16F873/74/76/77.

PP84 es un programador sencillo del tipo NOPPP de
buenas prestaciones.

Un circuito con PIC siempre se compone de dos sec-
ciones. El circuito del dispositivo deseado y los necesa-
rios componentes periféricos imprescindibles para que el
PIC funcione, a saber clock y reset (la primer sección
cambia con cada proyecto, en tanto que la segunda pue-
de ser común a muchos proyectos). Ambos circuitos peri-

féricos tienen diferentes opciones: el clock puede ser a
cristal cuando se requiera precisión, o a RC (como en
nuestro caso) cuando sólo se requiere que la secuencia
de encendido tenga un tiempo aproximado. En cuanto al
reset, éste puede ser externo con un pulsador o interno y
automático, cada vez que se conecta la alimentación de
5V.

Una vez definidas estas cosas se puede dibujar el cir-

cuito completo, tal como lo mostramos en la figura 13.
Observemos primero la sección periférica imprescin-

dible. El clock está generado por un oscilador RC realiza-
do con el PIC, R1 y C1 (elegidos para obtener una se-
cuencia completa que dure un segundo aproximadamen-
te), en tanto que el reset se realiza en forma automática,
cada vez que se enciende el equipo, por intermedio de
R6. Nuestro circuito de aplicación no puede ser más sen-
cillo, sólo utilizamos  cuatro LEDs sobre las patas RA0 a
RA3 (puerto “A” tomado parcialmente) y sus correspon-
dientes resistores de pull up (resistores a fuente). Nada
más simple y fácil de armar en un panel protoboard.

¿Qué ocurriría si compro los componentes, los armo
y pruebo directamente el circuito? 

No va a funcionar porque como el PIC no está instrui-
do para realizar ninguna función y los LEDs van a perma-
necer todos encendidos. El PIC tiene una memoria inter-
na que debe cargarse con números binarios de 8 dígitos;
exactamente tiene 48 posiciones de memoria (numera-
das desde el 0 hasta el 2F en números hexadecimales),
en donde se le indicará qué tarea debe realizar o qué da-
tos fijos debe cargar para ejecutar esas tareas.

En nuestro caso activar transistores internos en algu-
nas patas del puerto “A” (predispuestas como salidas) de
modo de generar cortocircuitos momentáneos a masa en
forma secuencial.

Los Cargadores de PICs
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El dispositivo con un zócalo para conectar el PIC e
instruirlo (cargarle los datos en la memoria de program-
na) se llama genéricamente “Programador de PICs”, pe-
ro nosotros en este artículo convenimos en llamarlo “Car-
gador de PICs” y es como un apéndice de nuestra PC,
conectado con un cable al puerto paralelo de la misma.

Si la PC tiene dos puertos paralelos de salida se usa-
rá uno para la impresora y el otro para nuestro programa-
dor, si sólo tiene uno, se desconectará provisoriamente la
impresora para conectar el programador, o mejor aún, se
conectarán ambos dispositivos a través de una caja se-
lectora que se consigue en los negocios de computado-
ras y se usa para conectar dos impresoras a la misma
PC.

Si Ud. tiene un mínimo conocimiento sobre computa-
doras, sabrá que un dispositivo conectado a la PC es to-
talmente inútil si no está acompañado de un programa
instalado en el disco rígido de la misma. En algunos ca-
sos se necesitan dos programas, a saber: el driver del
dispositivo y un programa de aplicación que utilice dicho
dispositivo. En el caso de dispositivos que se conectan en
el puerto paralelo, el programa driver no es necesario
porque dicho puerto ya está debidamente habilitado para
usar la impresora. Lo que sí se requiere obligatoriamen-
te, es un software de aplicación del programador que
suele proveerlo el fabricante del mismo.

Programadores y software de aplicación de los mis-
mos hay muchos. Algunos son muy simples y económi-
cos (tan económicos que muchos se entregan gratuita-
mente por Internet, es decir que el autor regala el softwa-
re y da las explicaciones para armar el hardware) y otros
son muy complejos y caros. La diferencia entre unos y
otros suele ser la posibilidad de aceptar más tipos de
PICs (además del 16C84 y 16F84 existen muchos otros)
e inclusive microprocesadores o memorias de otras mar-
cas. También se diferencian en la velocidad a la cual car-
gan el PIC; los hay de alta productividad que trabajan con
un elevado flujo de datos y otros más lentos que sólo sir-
ven para tareas de aprendizaje.

En nuestro caso vamos a trabajar con un software
que se llama NOPPP, que es absolutamente gratuito y se
puede bajar desde Internet. Este software está previsto
para ser usado sólo con los PIC16C84, PIC16C83 y
PIC16F84 que son los más utilizados.

Con respecto al hardware, Ud. puede usar el que pro-
pone el autor del software que es muy sencillo o usar otro
que le propongo yo más adelante y que tiene algunas
ventajas con respecto a una mejor forma de los pulsos de
programación. El NOPPP es suficientemente sencillo co-
mo para implementarlo en un panel protoboard, pero co-

mo es un hardware que deberemos usar más adelante
para programar otros PICs conviene armarlo en forma
más definitiva utilizando una plaqueta de circuito impreso
o una plaqueta ojalillada. Si Ud. sólo desea armar el cir-
cuito de este artículo puede armar tanto el cargador co-
mo el circuito de aplicación en dos lugares distintos del
mismo protoboard.

El PIC, como una memoria, tiene una pata que pre-
dispone el dispositivo para leer o para escribir. Si la pata
4 del PIC está a un potencial comprendido entre 13 y 14
V, el PIC está preparado para escribir los datos que pro-
vienen de la PC. Si la pata 4 está por debajo de 6V, el dis-
positivo está previsto para ser leído. Los datos a leer o es-
cribir se ponen/obtienen de la pata 13 del PIC con la pa-
ta 12 del mismo que opera como clock.

Aquellos que conocen el proceso de carga de datos
en una memoria serie, no tendrán mayores inconvenien-
te en entender la frase anterior. Para aquellos que no co-
nocen el proceso explicamos lo siguiente:

Un PIC se lee/escribe accediendo a las diferentes po-
siciones de memoria por la misma pata por la que se ob-
tienen/ingresan los datos (la pata 13). La señal primero
elige la posición de memoria a ser leída/escrita, y luego
que esa posición está accesible se escriben/leen los da-
tos. El clock que se coloca en la pata 12 sirve para indi-
car en qué momento se debe transferir la información.
Los datos pueden estar sobre la pata 13 todo el tiempo
que Ud. desee, ya que no serán ni leídos ni escritos por
la PC hasta que se produzca un cambio de estado (de al-
to para bajo) en la pata 12.

En la figura 14 mostramos las formas de señal indica-
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das por Microchip para leer/grabar un PIC.
El lector observará que dentro del comando existe

una primera sección de 6 bits que indica la posición de
memoria a ser leída/escrita y luego la línea de datos per-
manece en estado de alta impedancia por un intervalo de
tiempo que depende de la operación (durante ese tiempo
el clock está apagado). Por último ingresan/egresan los
datos. Las conexiones de fuente y las señales deben ser
aplicadas según una secuencia predeterminada que de-
be respetarse invariablemente. Los nombres de las seña-
les se aclaran en la figura 15.

A) El primer paso es colocar el PIC en el zócalo del
programador con señales y fuentes a potencial de masa.

B) Levantar la tensión de fuente VDD a un potencial
de 5V ± 0,2V por la pata 14 (VDD).

C) Levantar la tensión de fuente VPP a un potencial
de 13V ± 0,3V por la pata 4 (MCLR NEGADO).

D) Esperar en esas condiciones un tiempo superior a
1mS.

E) Posicionar el primer dato en la pata 13 (RB7) con
un potencial alto (mayor a 4 V) o bajo (menor a 1V).

F) Cuando la pata 12 (RB6) pase a un estado bajo, in-
ferior a 1V, el dato  se carga en la memoria.

G) Continuar cargando los datos con el mismo crite-
rio a un ritmo tal que el dato este presente por lo menos
durante 100nS.

H) Cuando todos los datos fueron cargados se debe
esperar 1 segundo.

I) Desconectar la fuente de 13V.
J) Desconectar la fuente de 5V.
K) Retirar el micro grabado.

Por sobre todas las cosas debe respetarse el cri-
terio de no sacar un PIC de su zócalo con las fuentes
conectadas, porque puede desprogramarse o, peor
aún, dañarse definitivamente. También es muy impor-
tante respetar las tensiones de fuente y no demorar
la llegada de datos, luego conectar VPP (porque po-
drían cargarse datos falsos por interferencias electro-
magnéticas).

Como usted puede observar de la descripción
anterior la entrada RB6 es utilizada como clock y la
RB7 como entrada de datos en una clásica operación
de transferencia de datos en serie.

Observe que hay un tiempo entre el momento en
que MCLR NEGADO sale de la condición de reset
hasta que aparece el primer dato o el primer pulso de
clock. También hay un tiempo mínimo para la perma-
nencia de un dato en la entrada (la representación

usada para un dato significa que el mismo puede ser alto
o bajo, depende del bit que se esté grabando). Lo que no
hay es un tiempo máximo pero evidentemente cuando
mayor es este tiempo más lenta será la carga del progra-
ma.

El tiempo más adecuado depende de factores tales
como el largo del cable utilizado para conectar el progra-
mador a la PC. Si el cable es largo, los pulsos tienden a
deformarse y atenuarse, sobre todo cuando son de corta
duración (100nS equivalen a una frecuencia de 10MHz).
Para evitar problemas, todos los programadores trabajan
a velocidades inferiores a la máxima, sobre todo conside-
rando que la capacidad de memoria no es muy grande y
para el uso no comercial no son imprescindibles grandes
velocidades de grabación.

Un cargador de PIC debe permitir también una ope-
ración de verificación para cuando el usuario tiene dudas
respecto de la condición de un determinado PIC (vacío o
lleno). Solo que el programa almacenado debe ser invio-
lable en caso de que la persona que lo cargó así lo haya
dispuesto. Esto se llama predisponer el PIC y no sólo se
lo predispone para hacerlo inviolable, sino que además
se determinan otros importantes parámetros de funciona-
miento como por ejemplo que esté predispuesto para un
clock a RC o que contenga un temporizador de reset in-
terno.

Las predisposiciones no forman parte del programa
del PIC aunque pueden incluirse junto con éste. Algunos
cargadores de PICs preguntan sobre la predisposición
antes de grabar el PIC. La pregunta sobre la predisposi-
ción deseada aparece en la pantalla de la PC y uno elige
de un menú de opciones. En otros casos, las predisposi-
ciones se escriben antes del programa en una secuencia
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perfectamente predeterminada que debe respetarse a ul-
tranza. Las predisposiciones son tres y las vamos a ana-
lizar por orden:

a) La prohibición de lectura. El PIC se programa pe-
ro el programa no puede ser leído. Cada tanto aparece in-
formación en Internet sobre alguna empresa dedicada a
leer PICs protegidos, sin embargo, aún no he conseguido
leer ningún PIC protegido. Aclaremos que el programa
protegido no se puede leer, pero el PIC se puede volver
a grabar. El autor escuchó también una especie que dice
que el PIC16Fxx fue creado por una supuesta filtración
en el secreto del programa de los PIC16Cxx, pero el au-
tor no tiene pruebas de la certeza de esta noticia.

b) Habilitación del timer de reset. En el pinup del
PIC se puede observar que la pata llamada MCLR nega-
do (4) tiene un doble uso. En principio sirve para predis-
poner el PIC en grabación o lectura, como ya fuera co-
mentado; pero cuando su tensión cae por debajo de 1V,
el PIC se resetea y comienza la lectura del programa por
el principio. Este tipo de reset se llama reset a pulsador y
se utiliza para provocar alguna acción como, por ejemplo,
comenzar una secuencia de encendidos de LEDS o en-
cender un LED por un tiempo predeterminado. Este mo-
do de funcionamiento requiere una acción externa de re-
set (apretar un pulsador). La misma acción de reset se
puede conseguir en forma automática cada vez que se
conecta la fuente de 5V. Este modo de trabajar sólo re-
quiere que la pata MCLR (pata 4) esté permanentemen-
te conectada a 5V (con un puente o un resistor de 1kΩ) y
que el PIC esté predispuesto con el Power-up Timer en
ON (temporizador de encendido conectado). Cuando el
temporizador está habilitado, luego de conectar la fuente
de 5V, comienza un conteo interno (que dura 72ms) du-
rante el cual el PIC pone todas sus compuertas internas
en cero (reset) y recién después comienza a efectuar los
pasos que le indica el programa. A propósito, el nombre
MCLR proviene de MASTER CLEAR (literalmente, lim-
piador maestro).

c) Circuito de vigilancia (perro guardián). En reali-
dad el PIC tiene un reset extra que opera luego de un
cierto tiempo si no se realiza la operación final del progra-
ma. Es como una especie de rutina automática de des-
congelamiento que opera en caso de falla del programa.
Eventualmente puede ingresar algún pulso de energía al
sistema que envíe al programa a un loop (rizo) eterno
(una derivación o camino cerrado sobre sí mismo). Una
vez que el programa ingresó en ese camino no puede sa-
lir de él salvo que se produzca un reset. Si pasa un tiem-
po considerable sin que se llegue a la última sentencia

del programa, el PIC analiza su predisposición y si el
Watchdog timer (literalmente perro guardián) está habili-
tado provoca un reset programado. En los programas
más simples y donde se producen loops infinitos a propó-
sito (de los que sólo se sale  tocando un pulsador), se
suele dejar el perro guardián desconectado para evitar un
funcionamiento errático. Cada cargador de programas
tiene un software diferente y esto implica que las predis-
posiciones anteriores, también llamadas fusibles de pre-
disposición se accionen con sentencias diferentes que
serán explicadas más adelante.

EL CARGADOR NOPPP
El NOPPP es un software para un cargador muy sim-

ple y efectivo. Realmente no tiene defectos importantes y
nos permite cargar los PIC 16C83, 16C84 y 16F84 en for-
ma muy económica ya que el hardware correspondiente
sólo requiere dos diodos rápidos de señal, un BC548 y 4
resistores, además de una fuente regulada doble de 13 y
5V y un conector para el puerto paralelo de la PC. Más
adelante veremos el circuito completo pero para entender
el funcionamiento del cargador de programas nada mejor
que el circuito simplificado de la figura 16. A propósito, el
nombre del software proviene de las iniciales de NO Pie-
ce Programer Pic, es decir: programador para PIC sin pie-
zas en alusión a los muy pocos componentes que requie-
re. Las patas de comunicación con el puerto paralelo de
la PC están indicadas como 1J1, 2J1, etc, ya con J1 de-
signamos al conector de entrada y el número inicial indi-
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ca a qué pata se dirige el cable (también incluimos el co-
lor del mismo). Los datos (oscilando de 0 o 5V) ingresan
en sucesión por el cable 14J1 y, atravesando el resistor
R2, llegan a la pata 13 del PIC. La pata 13 perteneciente
al puerto “B” se comporta como una pata de entrada de
datos en tanto el cable 2J1 se encuentra en el estado ba-
jo es decir que la pata 4 Vpp está a un potencial de 13V
aproximadamente.

Al mismo tiempo, el cable 17J1 se manda a potencial
de masa para que los datos entrantes no salgan a su vez
por el cable 11J1; de este modo, el diodo D1 no permite
que el potencial del cable supere la tensión de barrera del
diodo (es decir que el diodo D1 opera como una llave).
Como ya sabemos los datos deben ser validados por me-
dio de un cambio de estado de la señal de clock que in-
gresa desde la PC por el cable 1J1.

Fórmese una imagen mental del flujo de datos. Pien-
se en la PC como si bombeara datos al PIC por el cable
14J1; el PIC, para no inflarse, los devuelve por el cable
11J1. En realidad, los datos ingresan por la pata 13 del
PIC y se instalan en la memoria; pero a continuación, el
programa de carga verifica que el dato esté en la posición
de memoria correspondiente y si así ocurre, se habilita la
carga del siguiente dato. La secuencia es tal que:

A) se direcciona una posición de la memoria, 
B) se graba, 
C) se verifica esta última grabación y si es correcta,
D) se habilita al programa para cargar el siguiente dato.

De acuerdo al programa de carga, si falla la carga de
un dato se puede seguir con los otros y al final se intenta
la carga del dato que no se cargó. En otros, una falla de
verificación significa que el programa debe volver a car-

garse completo.
Ahora que conoce-

mos el funcionamiento
del cargador de progra-
mas NOPPP vamos a
completar el circuito
con una fuente de ali-
mentación y el conec-
tor para PC (figura 17).

Observe que las
fuentes están confor-
madas por dos regula-
dores de 5 y de 12V
pero, como necesita-
mos un regulador de
13V, realizamos una

pequeña modificación en el regulador de 12V; agregando
los diodos D1 y D2 la tensión de salida se incrementa a
un valor de 13,2V. El otro cambio importante es el agre-
gado de capacitores de filtro que, como Ud. observa,
siempre se ubican de a dos: un electrolítico para filtrar las
bajas frecuencias y un cerámico disco para las altas fre-
cuencias.

Por último se agrega un conector del tipo DB21 ma-
cho para conectar el dispositivo directamente a la salida
de la impresora de una PC. En el circuito dibujamos el co-
nector visto por el lado de las patas de conexiones y el
código de colores de cable adecuado para usar un cable
plano de 5 hilos (negro, marrón, rojo, naranja y amarillo)
al cual se le retuerce por encima otro de color blanco que
opera como masa y blindaje. Todo este circuito es suma-
mente sencillo y si Ud. sólo quiere conocer los PICs me-
diante este manual técnico, pero no se va dedicar a tra-
bajar permanentemente con ellos, puede armarlo en un
módulo de armado sin soldaduras (protoboard) junto con
el circuito de un destellador rítmico (figura 18).
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CARGADOR UNIVERSAL DE PICS

En varias direcciones de internet aparece el circuito
que describiremos a continuación, adjudicándole la auto-
ría a diferentes personas. La versión que reproducimos
es en base al trabajo de un tal “Droky” de
RaDiKAl ByTEs. Nuestros técnicos han
realizado algunas modificaciones y el resul-
tado es el siguiente:

Con este proyecto se puede realizar un
programador para PICs y EEPROMs de la
serie 24LXxx que funciona bien y requiere
pocos componentes externos.

El circuito está basado en el “Luddi” o
programador de JDM (vea: www.jdm.com),
siendo compatible con diferentes softwares
cargadores. Se ha probado en diferentes
computadoras desde un Pentium 100 has-
ta un Pentium III de 850MHz sin inconve-
nientes. No requiere de ningún tipo de
adaptador, y en tres zócalos que dispone,
podemos programar:

- PIC12C508 /A, PIC12C509 /A
- PIC12C67x
- PIC16C55x
- PIC16C61
- PIC16C62x
- PIC16C71
- PIC16C71x

- PIC16C8x
- PIC16F8x
- PIC16F873/4/6/7 (Modelos de 28 patillas)
- PIC16C73B/74B/76/77
- EEPROMs de la serie 24LCxx

Cargador Universal de PICs
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En la figura 19 se muestra el circuito del cargador y
en la 20 la placa de circuito impreso propuesta.

El tamaño del cargador es bastante reducido y posee
bases (zócalos) para la mayoría de los chips que puede
programar (siempre en encapsulado DIL no en TSOP,
SMD ni otros formatos).

Si bien es posible utilizar distintos tipos de softwares,
hemos realizado experiencias con el italque, el desden, el
pix y el icprog. Es precisamente el icprog el que permite
“cargar” a casi todos los chips indicados y lo puede bajar
gratuitamente siguiendo los pasos que mencionamos an-
teriormente, utilizando la clave de acceso: aiwa15.

El programa pix se puede usar para los PIC16F8x y
PIC16C8x, es rápido y permite bastantes opciones. Para
las EEPROM 24LCxx, pueden emplearse tanto el Icprog
como el PIX .

Para los 12C508/A y 12C509 /A lo más seguro es
usar el prog508 y el prog509 (vea los foros PSX) y que se
pueden descargar de la página de JDM.

La lista de materiales del cargador universal es la si-
guiente:

C1 - 22µF , 16v Tantalio/Electrolítico
C2 - 100µF , 16v Tantalio/Electrolítico
C3, C4 - 0,001µF - Cerámico

D1,D2,D3,D4 - 1N4148
D5 - 5.1V 1/2W
D6 - 8.2V 1/2W
J1 - Zócalo 24LCXX 8 Patillas
J2 - Zócalo PIC 18 Patillas
J3 - Zócalo PIC 28 Patillas
P2 - CONNECTOR DB9 Hembra
Q1,Q2 - BC548B
Q3 - BC558B
R1 - 100kΩ
R2 - 10kΩ
R3 - 1k5

LOS OTROS CARGADORES:
Como hemos dicho, existen muchos circuitos carga-

dores de PICs que se pueden bajar de Internet.
En la figura 21 se observa el PIC800 que es un pro-

gramador para 16C84, 16F84, 16F873/74/76/77 que está
presentado en la web por Miguel Scapolla (www.miguelo-
.com.ar).

El PICPRO es un programador avanzado en relación
con el NOPPP y sirve para ser montado cuando no se
quieren correr riesgos con la PC que se está utilizando

para cargar PICs
y cuando se de-
sea tener un tra-
bajo libre de erro-
res (el NOPPP es
un programa para
aprendizaje). Su
circuito se lo pue-
de ver en la figura
22. Por último, el
PP84 es un pro-
gramador sencillo
del tipo NOPPP
de buenas presta-
ciones (figura 23).

Si desea ob-
tener los progra-
mas que permitan
manejar a estos
c a r g a d a o r e s ,
puede buscarlos
en Internet o con-
sultar a: ateclien-
@webelectroni-
ca.com.ar
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INTRODUCCIÓN

Una instrucción es un comando, parte del programa,
que se le aplica al PIC para que lo interprete y ejecute su
cumplimiento. La instrucción se compone de una serie de
bits presentada en secciones o posiciones perfectamen-
te delimitadas, que el procesador interpreta para cumplir
una orden deseada, quedando establecidas las variables
que se modifican.

Dicho de otra forma, las instrucciones poseen un for-
mato de acuerdo a un sistema de codificación. El forma-
to cambia de acuerdo con la operación que se va a rea-
lizar.

Cada instrucción, para la línea baja de los PICs tipo
16C5X, consiste en una palabra de 12 bits que codifica
en un solo bloque, la orden, el operador y la ubicación del
resultado o el salto (en caso de que lo hubiere). En los
microcontroladores PICs tipo 16X84 cada instrucción tie-
ne una longitud de 14 bits.

Los bits que actúan como datos de la memoria
EPROM se reciben en el decodificador de instrucciones,
y operan con el contador de programa y el registro de tra-
bajo W, para acceder a lugares específicos del microcon-
trolador, tales como la ALU, posiciones de memoria, re-
gistros, etc.

Como sabemos, los PICs 16X84, entre otros, mane-
jan un set reducido de instrucciones (35 instrucciones en
lo que se denomina RISC) que presentan una codifica-
ción muy particular llamada “formato de la instrucción”.

Cada instrucción posee su formato y es total-
mente definido por MICROCHIP.

En la figura 24 podemos apreciar “la sintaxis” de
una instrucción del set. Se trata de la instrucción que
suma el contenido del registro de trabajo con el con-
tenido de un registro cuya dirección está determina-
da por el operador “f”. En esta figura, en primer lugar
se observa la “sintaxis”, es decir, la forma en que el
programador escribirá la instrucción en el lenguaje
“entendible por el operador” (el programa en .asm).
La codificación es el formato de la palabra que defi-
ne la instrucción y que veremos en detalle luego. No-
te que para que se complete la instrucción se nece-
sita una sola palabra y un solo ciclo del contador de

programas.
Como veremos, el resultado de la operación se guar-

da en un sitio definido por el programador (dependiendo
de qué estado tome el bit “d”) y que esta instrucción mo-
difica los bits C, DC y Z del registro de estado (STATUS).

Esto quiere decir que cuando coloco la instrucción:

ADDWF  f,d

El ensamblador generará el código:
0001 11df ffff

En este código, los seis bits de mayor peso (bits 6 al
11 en la figura 25) definen la operación que va a realizar
la instrucción de acuerdo a lo requerido por el programa-

El Set de Instrucciones
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Manejo de las Instrucciones de un PIC

Aprenda a manejar el set RISC de un PIC para realizar sus propios programas.

Figura 24Figura 24

Figura 25Figura 25
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dor. Aquí se define una orden que el PIC interpreta y eje-
cuta sobre un operando determinado, cuya dirección la
busca según lo indicado por los 5 bits menos significati-
vos (bits 0 al 4 en la figura 25).

El bit 5 es un código de reconocimiento de destino y
determina en qué lugar se va a alojar el resultado de la
operación. Si este bit es “0” el destino de la operación se-
rá puesto en el registro de trabajo (W). Si el bit “d” es
puesto a “1” el destino será el de la posición de memoria
definido por “f”.

Los cinco bits de menor peso en el formato de la ins-
trucción representan la dirección donde está guardado el
operando (f), que está en la memoria de datos y por te-
ner cinco bits sólo podemos direccionar una de las 32 po-
siciones de memoria de datos.

La mayoría de las instrucciones se realizan en un ci-
clo de contador de programa (ciclo de instrucción) excep-
to las instrucciones de salto que necesitan dos ciclos pa-
ra ejecutarla. Se determina el ciclo de instrucción divi-
diendo por cuatro la frecuencia del oscilador, elegida pa-
ra el funcionamiento del microcontrolador tal como se ob-
serva en la figura 26.

Es decir, la señal que proviene del oscilador externo,
conectado a los pines OSC1/CLKIN y OSC2/CLKOUT del
microcontrolador, se divide en cuatro ciclos, obteniéndo-
se así la señal requerida por el procesador interno para
realizar las operaciones. De esta manera se puede reali-
zar la búsqueda y ejecución de la instrucción.

El reloj de instrucción es el ciclo interno que posee el
microcontrolador para cronometrar el tiempo de ejecución
de las instrucciones.

Los pulsos entrantes del reloj son divididos por 4, ge-
nerando diferentes señales denominadas Q1, Q2, Q3 y
Q4. El estado Q1 hace incrementar el contador de progra-
ma, Q2 y Q3, se encargan de la decodificación y ejecu-
ción de la instrucción y por último, Q4 es la fase de bús-
queda de la instrucción. El código se almacena en el re-
gistro de instrucciones.

EL SET DE INSTRUCCIONES DEL 16X84

Vimos cómo es la estructura de una instrucción, ra-
zón por la cual le recomendamos que lea nuevamente el
comienzo de este capítulo si no entiende lo que a conti-
nuación expresaremos.

Los códigos (denominados mnemónicos) que simbo-
lizan un conjunto de instrucciones, representan la tarea
que debe hacer el microcontrolador una vez que las ana-
lice en función del operando.

Un mnemónico ayuda a recordar el significado que
tiene la instrucción.

Para poder analizar al conjunto de instrucciones que
conforman el set RISC, se los suele agrupar teniendo en
cuenta el tipo de operación que realizan, así es común
que se las presente bajo cuatro posibles formas, a saber:

1. Instrucciones orientadas a registros.
2. Instrucciones orientadas a bits.
3. Instrucciones con literales.
4. Instrucciones de control y especiales.

En la figura 27 vemos un cuadro
donde se reproducen las instruccio-
nes orientadas a registros, la figura
28 muestra las operaciones orienta-
das a bits y la figura 29 nos permite
conocer cuáles son las instrucciones
con literales y de control.

Sobre las notas a las que hace-
mos referencia en dichas figuras, de-
be tener en cuenta lo siguiente:

Nota 1. Al modificar un registro
de entrada/salida  (E/S) con una
operación sobre él mismo (por ejem-
plo MOVF PORTB,1), el valor utiliza-
do es el que se encuentre presente
en las patas del PORTB. Por ejem-
plo, si el biestable tiene un "1" para
una pata configurada como entrada
y se pone a nivel bajo desde el exte-

El Set de Instrucciones
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rior, el dato se volverá a escribir como un "0".
Nota 2. Si se ejecuta esta instrucción sobre el TMR0

y d=1, será borrado el divisor de frecuencia (preescaler),
si está asignado al TMR0.

Nota 3. Si se modifica el Contador de Programa (PC
ó CP) o es verdadera una condición de prueba, la instruc-
ción requiere dos ciclos de máquina. El segundo ciclo se
ejecuta como un NOPPP.

El Set de Instrucciones
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Figura 29Figura 29

Programación de PICs
Aprendiendo a Programar: Carga y Programación de PICs
Sepa cómo es la estructura de un programa y cómo se deben utilizar las instrucciones.

CIRCUITO DE UN

ENTRENADOR

En Saber Electrónica hemos
desarrollado un “entrenador” para
aprender a programar y cargar
PICs, este entrenador se muestra
en la figura 30.

Antes de dar los primeros
ejemplos es conveniente tener en
cuenta los siguientes conceptos:

1) En todo programa se debe
decir cuál es el tipo de PIC que se
empleará, hay que incluir sus libre-
rías y configurarlo:

Figura 30Figura 30
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Ejemplo:
list p=16f84
include <p16f84.inc>
__config_RC_OSC &_WDT_OFF

2) Al escribir un programa se realizan las sentencias
en columnas.

La primera columna se utiliza para nombrar varia-
bles o colocar etiquetas. La segunda columna se utiliza
para aplicar la instrucción. La tercer columna contiene
los datos necesarios para que pueda ejecutarse dicha
instrucción. La cuarta columna contiene datos útiles pa-
ra el programador pero que no son tenidos en cuenta
por el microcontrolador.

Ejemplo:
Voy a definir a la variable M en la posición de memo-

ria expresada en número decimal ‘26’:

1ª Col. 2ª Col. 3ª Col. 4ªCol.
M equ D‘26’ ;definí a la variable M en 

;la posición 26.

M es la variable que definí
equ es la instrucción que significa asignar o definir
D ‘26’ es la posición de memoria expresada en nú-

mero decimal.

3) Se emplean signos para efectuar determinadas
consideraciones, por ejemplo:

; se emplea para colocar observaciones. El progra-
ma no toma en cuenta todo lo que está en una línea
luego de dicho signo.

: se utiliza normalmente para definir etiquetas, que
son lugares a donde va el programa cuando así lo re-
quiere.

‘’ se utiliza para decir que lo que está entre ellas es
el número y puede estar expresado en lenguaje deci-
mal, binario o hexadecimal.

. se emplea para definir un número en decimal.

Ejemplo:

R equ .28 ;definí a la variable R en la posición
;de memoria 28

lazo: rlf R,f ;roto el contenido de  R y el resultado 
;queda en R 

4) Un programa siempre “debería” comenzar con la

instrucción org y terminar con la instrucción end.
Este manual no pretende ser un “tratado” de progra-

mación y su objetivo es capacitar al estudiante y aficio-
nado en el uso y carga de programa de un PIC. Si Ud.
desea obtener una capacitación completa le recomenda-
mos estudiar el “Curso Completo de PICs” preparado
por Editorial Quark y que se compone de dos textos, un
CD y un video de entrenamiento.

PROGRAMAS DE PRÁCTICA

Sea el programa:

; Primer programa de práctica

List p = 16C84 ; voy a utilizar el PIC16C84
ptob equ 0x06 ; inicializo la variable ptob en 

; la dirección 06h
Reset org h’0’ ; comienza el programa
Inicio movlw h’0’ ; cargo a W con 0

tris ptob ; mando el contenido de W a ptob
movlw h’0f’ ; cargo a W con el número binario 15

ciclo nop ; rutina nula
goto ciclo ; vaya a ciclo

El programa comienza con un (;), por lo tanto, lo que
sigue en el renglón es tomado como un comentario. Los
signos = forman un resalte para indicar el inicio del pro-
grama y ayudan a darle una distribución agradable a la
vista. El programa se lista en cuatro columnas; la primera
sirve para colocar las “variables” que utilizaremos como
registros y las “etiquetas” que son ubicaciones del progra-
ma adónde se debe ir cuando el operando de una instruc-
ción así lo requiera.

En la segunda columna se coloca la instrucción y en
la tercera el operando de la instrucción. La cuarta colum-
na siempre va precedida de (;) y se utiliza para colocar
observaciones que le sirvan al programador como guía
para saber qué quiso hacer o qué función cumple esa
sentencia, obviamente, al compilar esa instrucción, las
observaciones no son tenidas en cuenta.

List  p = 16C84
Es el encabezado del programa que le indica al en-

samblador qué tipo de PIC se está utilizando para que és-
te pueda reconocer qué set de instrucción debe utilizar.

ptob equ 06
Nombré a la variable ptob y la coloqué en la dirección

Programación de PICs
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06 de la RAM, “esta dirección está reservada para el
PUERTO B”, es decir, ratifico que ptob es el registro del
PORT B. Cuando, más adelante, deba enviar información
al puerto b, sólo debo mencionar ptob.

Reset org 0 
Significa que al realizarse el reset, el programa co-

mienza por la posición 0 de la memoria del programa. Pe-
ro de inmediato pasa a la posición 1 que tiene escrita la
siguiente sentencia:

Inicio  movlw 0
Con esto se carga el registro w con el hexadecimal 0

(es decir el binario 00000000)

tris ptob
Esta instrucción envía la información del registro W al

puerto B para indicarle que todos sus pines son de salida
(si se hubiera cargado el binario 11111111 todos los pi-
nes serían de entrada y si se hubiera cargado 11001010
algunos serían entradas y otros salidas).

movlw 0f 
Carga el registro W con el hexadecimal 15 que equi-

vale al binario 00001111 y

movlw ptob
Envía el valor cargado al puerto "B" que producirá un

estado alto en RB0, RB1, RB2 y RB3 y un estado bajo en
RB4, RB5, RB6 y RB7. La información del puerto pasa al
buffer que lleva las patas 15, 16, 17 y 18 de un PIC16C84
a masa encendiendo los leds D7, D8, D9 Y D10.

Ciclo nop
Realiza una rutina nula, es decir, que no efectúa ope-

ración alguna.

goto ciclo
Envía el programa hacia la etiqueta "ciclo". Las dos

últimas operaciones hacen que al ejecutarse un progra-
ma, éste se quede en un lazo que se llama  “loop cerra-
do”.

La única manera de salir de este loop es pulsando
RESET. Entonces se observa que los leds se apagan
hasta que se suelta el pulsador y el programa comienza
nuevamente por la etiqueta RESET.

Obviamente, este programa debe ser editado en un
utilitario adecuado (MPLAB, por ejemplo) y luego debe
ser compilado (utilizando el MPASM o el mismo MPLAB)
para obtener el archivo .hex que me permitirá cargar el

PIC que deberé
colocar en el cir-
cuito de la figura 1
para verificar que
realmente “hace”
lo que estamos di-
ciendo.

Para cargar el
PIC con el progra-
ma .hex se utiliza
un prototipo ade-
cuado (cargador
de PICs) que con-
siste en un circui-
to que es maneja-
do por un progra-
ma para permitir
la carga. Todo este proceso se explica con total claridad
en el primer texto de esta serie, titulado: “Todo Sobre
PICs”.

En la figura 31 se puede observar un diagrama de flu-
jo que refleja el funcionamiento del programa que acaba-
mos de explicar.

¿Cuánto tardan en encenderse los leds luego de sol-
tar el botón de reset? 

Si se observa el circuito, se verá un cristal de clock de
4MHz (0,25µS de período); como internamente existe un
divisor x4  cada operación se realizará en 0,25 x 4 = 1µS.
Si contamos las sentencias hasta llegar a cargar el puer-
to B, veremos que hay 5 (cinco renglones de programa);
por lo tanto, la demora es de 5µS.

***************************

Veamos ahora algunos ejemplos de programas sen-
cillos que rápidamente podemos llevar a la práctica:

Programa que permite el encendido de
los dos bits menos significativos
del port B (figura 32)

list p=16f84
include <p16F84.inc>
org 0
movlW B'00000000'
tris PORTB
movlw B'00000011'
movwf PORTB
end
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En la figura 33 se observa el programa correspon-
diente a un secuenciador de 8 canales que hemos
editado en el programa MPLAB.

list p=16f84
include <p16f84.inc>
__CONFIG _RC_OSC & _WDT_OFF & _PWRTE_ON

Este juego de sentencias indica que se va a utili-
zar el PIC 16F84, se pide que se carguen las librerías
del PIC y se configura al programa para trabajar con
clock RC, el temporizador WDT apagado y el tempori-
zador libre activo.

j equ h'11'
k equ h'12'
Defino a las variables j y k en las posiciones de

memoria de dato 11 y 12 (en hexadecimal) respectiva-
mente.

org 0
Comienza el programa

movlw b'00000000'
tris PORTB

Con estas dos instrucciones digo que todas las
patas del PORTB serán salidas.

movlw b'00000001'
movwf PORTB

Mandé un “1” a la pata B0, es decir que si hay un
led conectado entre esa pata y masa, el mismo se en-
cenderá.

mloop: rlf PORTB,f
En esta sentencia coloqué una etiqueta (una mar-

ca) que será la posición a la que irá el programa en al-
gún momento, cuando se le dé la instrucción. Luego
con la instrucción rlf digo que se rote hacia la izquier-
da el contenido del registro PORTB, es decir que lue-
go de esta instrucción ahora mandé un “1” al bit B1 y
todas las demás patas quedan en cero, es decir, se
apaga el led conectado en B0 y se enciende el led co-
nectado en B1 (pata 7 del integrado).

movlw d'50'
movwf j

Puse en la posición de memoria j el número 50

jloop movwf k
Puse en la posición de memoria k el número 50,

además en esta sentencia coloqué una etiqueta y en

algún momento le diré al programa que vaya hacia
esa dirección.

kloop decfsz k,f
goto kloop

Ahora doy la instrucción para que se decremente
el contenido de la variable k y si ese contenido es “0”
entonces que salte una instrucción; sino es “0” enton-
ces mando al contador de programa a la etiqueta
kloop para que se haga un nuevo decremento. Es de-
cir, estoy haciendo un lazo cerrado para “perder tiem-
po”

decfsz j,f
goto jloop

Entro en un nuevo lazo cerrado cuando k=0, en
este caso para decrementar el contenido de la varia-
ble j.

Con este juego de instrucciones cuento “50 veces
50” (cuento hasta 2500) y con cada cuenta consumo
4 ciclos de reloj de modo que tardé 10.000 ciclos en
terminar el lazo completo. Si la frecuencia de reloj es
de 10.000Hz, entonces tardaré un segundo en com-
pletar el doble lazo.

goto mloop
Ahora mando al contador de programa a la posi-

ción donde está la etiqueta mloop para que se haga
una nueva rotación del contenido del PORTB, es de-
cir, se encenderá ahora otro led, apagándose el an-
terior. Esta rutina se sigue indefinidamente, es decir,
tenemos un secuenciador de 8 canales.

end
Indica que finalizó el programa.

De más está decir que ésta es una forma de progra-
mar “no muy adecuada” pero que sirve perfectamente pa-
ra que el lector aprenda a estructurar sus propios proyec-
tos.

Es aconsejable que al editar un programa lo haga en
el MPLAB (siguiendo los pasos que explicaremos más
adelante), pues de esta manera tendrá la oportunidad de
poder comprobar si ha cometido errores o no en su traba-
jo. El MPLAB es ideal porque la forma de manejarlo es
sencilla y sistemática.

A los fines prácticos, en la página siguiente damos el
programa correspondiente a un semáforo muy sencillo.
Le sugiero que intente seguir paso a paso cada instruc-
ción para comprender su estructura.
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PROGRAMA SECUENCIADOR DE 4 CANALES

list P=16C84 ;el dispositivo usa el 16C84
;------------------------------------------------------------------------------------------- 
ptob equ 06 ;el puerto B se ubica en 06 de la RAM.
Rot equ 0d ;al registro ubicado 0d se lo llama Rot.
Reg1 equ 0e ;al registro ubicado en 0e se lo llama reg1
reg2 equ 0f ;al registro ubicado en 0f se lo llama reg2
reg3 equ 10 ;al registro ubicado en 10 se lo llama reg3
grueso equ 00 ;se asignan nombres a los literales.
medio equ 40 ;se asignan nombres a los literales.
fino equ 50 ;se asignan nombres a los literales.
;-------------------------------------------------------------------------------------------
reset org 0 ;reset en dirección 00h

goto comenzar ;se lleva el control a comienzo
comenzar movlw 00 ;se carga w con 00h

tris ptob ;se programa el puerto "b" como salida.
ppal movlw 01 ;se carga w con 01h

movwf rot ;se descarga w en el registro rot 
;preparándolo para la rotación.

sec movf rot,0 ;el contenido de rot pasa a w
movwf ptob ;enciende el led conectado donde indica w
call demora ;se mantiene encendido el led.
rlf rot ;se mueven los bits de "rot".
btfss rot,4 ;se comprueba el 5º bit.
goto sec ;si el 5º bit es cero  se reenvía a sec.
goto ppal ;si el 5º bit es uno se reenvía a ppal para

;comenzar una nueva secuencia.
demora movlw grueso ;recarga w con el número hexadecimal 

;“grueso” es decir, con 30
movwf reg1 ;se vuelca “grueso” en el registro

;reg 1
dem3 movlw medio ;se carga w con el número hexadecimal

;“medio” es decir con 40
movwf reg2 ;se vuelca "medio" en el registro 

;reg2.
dem2 movlw fino ;se carga w con el número hexadecimal

;"fino" es decir con 50.
movwf reg3 ;se vuelca "fino" en el registro reg3.

dem1 decfsz reg3 ;se decrementa el registro reg3 en una
;unidad y si el resultado es cero se salta a 
;la siguiente instrucción, si no se sigue 
;decrementando.

goto dem1 ;retorno a la frecuencia etiqueta dem1.
decfsz reg2 ;idem con reg2.
goto dem2 ;retorno a la etiqueta dem2.
decfsz reg3 ;idem con reg1.
goto dem1 ;retorno a la etiqueta dem3.
retlw 0 ;se carga w con 0 y se retorna al

;programa principal.
end
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INTRODUCCIÓN

MPLAB es un entorno de desarrollo integrado que le
permite escribir y codificar los microcontroladores PIC de
Microchip para ejecutarlos. El MPLAB incluye un editor de
texto, funciones para el manejo de proyectos, un simula-
dor interno y una variedad de herramientas que lo ayuda-
rán a mantener y ejecutar su aplicación. También provee
una interfase de usuario para todos los productos con
lenguaje Microchip, programadores de dispositivos, siste-
mas emuladores y herramientas de tercer orden.

El MPLAB está diseñado para ser ejecutado bajo
Windows 3.11, y puede operar con Windows 95, 98 y su-
periores (vea www.microchip.com). Asume que el usuario
ya conoce el entorno de Windows y sabe manejarlo. La
guía que describimos le permitirá realizar las siguientes
tareas:

• Manejar el escritorio MPLAB
• Crear un nuevo archivo de código fuente para el en-

samble e ingresarlo a un nuevo proyecto para el 16F84
• Identificar y corregir los errores simples
• Ejecutar el simulador interno

Para que Ud. aprenda a programar sus microcontro-
ladores, damos a continuación, paso a paso, las instruc-
ciones de instalación y uso de la aplicación:

INSTALACIÓN

Descargue los archivos del software de instalación y
ejecute el archivo MPxxxxx.EXE. Estos archivos puede
obtenerlos por medio de Internet en la dirección:

http//www.microchip.com/10/Tools 

Estos archivos pueden ser transferidos a disquetes si
desea instalar el MPLAB en otra computadora. De acuer-
do a la versión que haya descargado, los nombres de los
archivos pueden variar levemente. Por ejemplo, la versión
4.00 del MPLAB tendría los siguientes archivos:

MP40000.EXE 
MP40000.WO2 
MP40000.WO3 
MP40000.WO4 
MP40000.WO5 
MP40000.WO6

Si Ud. lo prefiere, puede venir a nuestras oficinas con
este libro y 6 disquetes vírgenes y tendrá la oportunidad
de llevarse dicho programa sin cargo.

Copie el contenido de los 6 disquetes en el disco rígi-
do de su PC (en un lugar que pueda identificar).

Cuando ejecute el archivo .EXE, comenzará la insta-
lación del MPLAB en su sistema. Seguidamente deberá
elegir los componentes del MPLAB que desea instalar en
su sistema. A menos que haya comprado un programador
o emulador del dispositivo, sólo debiera instalar las si-
guientes herramientas del software:

Archivos MPLAB IDE 
Archivos MPASM/MPLINK/MPLIB
Archivos de Protección del Simulador MPLAB-SIM
Archivos de Ayuda (vea la figura 1 que aparecerá

cuando ejecute el programa).

Luego aparecerá el menú de la figura 35 que le per-
mitirá seleccionar los componentes de lenguaje Micro-
chip que desee instalar. Usualmente debiera seleccionar-
los todos (por defecto). Al hacer “doble click” en
MP40000.EXE, el instalador le va diciendo lo que debe

Edición y Simulación de Programas

Manejo del MPLAB
Edición y Simulación de Programas

Sepa cómo editar un programa y encontrar errores con el MPLAB.

Figura 35Figura 35
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hacer. Luego de instalarlos, ejecute MPLAB.EXE o clique
el ícono MPLAB para iniciar el sistema.

Aparecerá el escritorio del MPLAB (figura 36).

Configurar el Modo de Desarrollo
El escritorio básico del MPLAB se asemeja al de las

aplicaciones de Windows (como pudo ver en la pantalla
de la figura 36). Tiene una barra de menú en el margen
superior, una barra de herramientas y también una barra
de estado en el margen inferior. Podrá advertir que la ba-
rra de estado incluye información sobre cómo se ha con-
figurado el sistema.

Nota: El "modo de desarrollo""modo de desarrollo" determina la herra-
mienta, debe elegir alguna, que ejecutará el código. Para
esta guía, usaremos el simulador de software MPLAB-MPLAB-
SIMSIM. Si sabe del tema y tiene un emulador, en este capí-
tulo encontrará más información para cambiar a una de
sus operaciones. Al seleccionar el ítem del menú "Op-
ciones>Modo de Desarrollo", aparecerá una caja de
diálogo semejante a la de la figura 37.

El MPLAB es un producto en constante evolución, de
modo que pueden aparecer sutiles diferencias entre la
pantalla que usted vea y la que mostramos aquí. Selec-
cione el ícono próximo al Simulador MPLAB-SIM
(MPLAB-SIM Simulator) y elija 16F84 (que corresponde a
un tipo de PIC) en la lista de procesadores disponibles

que pueden ser resistidos por el simulador. Clique 16F84
y luego presione el botón "Reset". De este modo se ini-
ciará el simulador, y debería aparecer en la barra de es-
tado "16F84" y "Sim". Se encuentra así en el modo simu-
lador para el 16F84.

Cómo Crear un Proyecto Simple
El simulador se ejecutará desde el mismo archivo, lla-

mado "archivo hex", el cual puede ser programado en el
micro PIC. Para que se ejecute el simulador, primero de-
berá crear un archivo de código fuente y realizar el mon-
taje del código fuente.

A continuación explicaremos cómo llevar a cabo este
proceso:

Nota: El lenguaje ensamblador produce, entre otros
elementos, un archivo hex. Este archivo tiene la exten-
sión (.hex). A este archivo lo llamaremos:

tutor84.hex.

Más adelante este archivo puede ser cargado directa-
mente en el programador del dispositivo sin usar el en-
samblador o un proyecto del MPLAB. Este archivo tam-
bién puede ser cargado por otros programadores de ter-
cer orden.

Seleccione "Archivo>Nuevo (File>New)" en el me-
nú y aparecerá la caja de diálogo de la figura 38.

Clique en el botón Sí, seguidamente aparecerá un
diálogo de explora-
ción de Windows
estándard. Decida
dónde desea crear
su proyecto (en
qué carpeta o lugar
de su disco rígido
lo va a guardar) y
recuerde dónde lo
ubicó. Más tarde necesitará esta información. Esta guía
usa un directorio en c: \temp\tutorial y crea el archivo de
proyecto llamado tutor84.pjt (figura 39). "PJT" es el su-
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fijo estándar para los archivos de proyectos en el MPLAB.
El prefijo del nombre de archivo del proyecto, en este

caso "tutor84", será el prefijo por defecto de muchos de
los archivos que el MPLAB usará o creará para esta guía.
Clique "Aceptar (OK)" para que aparezca el diálogo Pro-
yecto MPLAB. Este diálogo puede parecer confuso, pero
en realidad es muy simple.

Nota: El simulador, los programadores y los sistemas
emuladores que operan con el MPLAB usan un archivo
hex creado por el ensamble, la compilación y/o el “linking”
del código fuente. Algunas herramientas diferentes pue-
den crear archivos hex, al tener en cuenta que estas he-
rramientas formarán parte de cada proyecto.

Los proyectos le dan la flexibilidad para describir có-
mo se construirá la aplicación y qué herramientas se usa-
rán para crear el archivo .hex. Obviamente, en la guía
nos ocuparemos de todos estos detalles.

El diálogo "Editar Proyecto" será semejante al mos-
trado en la figura 40.

Advierta que el nombre del archivo de destino ya ha
sido completado. Ya conoce el modo de desarrollo que
configuramos previamente y asume que usaremos la se-
rie de herramientas de lenguaje Microchip. En la ventana
"Archivos de Proyecto (Files proyect)", encontrará tu-
tor84. [hex]. Al destacar este nombre, se podrá utilizar el
ícono "Propiedades del Nodo (Node Properties)". Se-
guidamente debe indicarle al MPLAB cómo crear el archi-
vo hex. Hágalo clicando el botón "Propiedades del Nodo".

Aparecerá el diálogo "Propiedades del Nodo". Este diá-
logo contiene todas las configuraciones por defecto para
una herramienta de lenguaje -en este caso MPASM, co-
mo podrá ver en en el ángulo superior derecho del diálo-
go. En su forma más simple, el proyecto contiene un ar-
chivo hex creado desde un archivo fuente de ensamble.
Esta será la configuración por defecto cuando aparezca
el diálogo "Propiedades del Nodo (Node Properties)", vea
la figura 41.

Nota: Como puede ver, hay una cantidad de filas y
columnas en este diálogo.

Cada fila usualmente corresponde a un "cambio",
aquellos elementos que se establecen en la línea de co-
mando cuando se invoca una herramienta. De hecho, la
configuración de estos cambios se refleja en la ventana
"Línea de Comando (comand line)", próxima al margen
inferior de la pantalla. Esta es la línea de comando que se
usará cuando se invoque el MPASM desde el MPLAB. Por
el momento, puede usar las configuraciones por defecto,
pero cuando ya sepa construir una aplicación, probable-
mente deseará cambiar algunas.

Al clicar el botón "Aceptar (OK)", aplicará estas con-
figuraciones, y retornará al diálogo "Editar Proyecto
(Edit Project)", con el ícono (botón) "Agrega Nodo (Add
Node)" disponible. Presione el botón "Agregar Nodo".
Aparecerá el diálogo de exploración de Windows están-
dar, con el mismo directorio usado para el proyecto. Ingre-
se el nombre de archivo: tutor84.asm y presione "Acep-
tar". Retornará al diálogo "Editar Proyecto", donde po-
drá ver "tutor84.asm" añadido debajo del archivo hex,
que indica que es un nodo concurrente. Al presionar
"Aceptar", retornará al escritorio MPLAB con un archivo
de código fuente abierto y aún sin nombre.

Cómo Crear un nuevo Archivo Fuente Simple
Clique dentro del espacio en blanco de la ventana de

archivo creada. Seguramente se llamará "Sin título (Un-
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titled)". De este modo accederá al "foco" de la ventana.
Use la opción de menú "Archivo>Guardar como...", y
guarde el archivo vacío como tutor84.asm. Cuando abra
el diálogo de exploración estándar, encontrará su ubica-
ción en el directorio del proyecto. Ingrese el nombre de ar-
chivo y presione "Aceptar". Vea la figura 42.

Ahora estarán disponibles el escritorio MPLAB y la
ventana de archivo vacío, pero el nombre de la ventana
de archivo reflejará su nuevo nombre.

Nota: El nombre del archivo fuente y el nombre del
proyecto ("tutor84" en esta guía) deben ser iguales en es-
te tipo de proyectos. Hay otros proyectos de archivo múl-
tiple que usan el “lin-
ker” y permiten que
el nombre del archi-
vo de salida sea di-
ferente al del archi-
vo de entrada (hay
una guía aparte pa-
ra los proyectos de
archivos múltiples
que usan el linker).

El MPASM
siempre creará un
archivo hex de sali-
da con el mismo
nombre que el archi-
vo fuente, y esta
configuración no
puede modificarse.
Si cambia el nombre
del archivo fuente,
también deberá
cambiar el nombre
del proyecto. Ahora

ya está listo para escribir el código que almacenará en el
PIC para que cumpla una función determinada.

Ingresar el Código Fuente
Use el mouse para ubicar el cursor al comienzo de la

ventana de archivo vacío tutor84.asm, e ingrese el texto
de la tabla 1, exactamente como está escrito en cada lí-
nea. No debe ingresar los comentarios (los textos que si-
guen a cada punto y coma).

Este código es un programa muy simple que incre-
menta un contador y lo "resetea" a un valor predetermina-
do cuando el contador vuelve a cero.

Nota: Todos los rótulos comienzan en la primera co-
lumna, y la última línea tiene una directiva "end". Las pá-
ginas de datos del micro PIC contienen información com-
pleta sobre instrucciones con ejemplos para su uso.

Guarde el archivo usando la función de menú "Archi-
vo>Guardar" (File>Save).

Ensamble del Archivo Fuente
El ensamble del archivo puede realizarse de varias

maneras. Aquí describiremos un método. Use el ítem de
menú "Proyecto>Construir todo (Proyect>Build All)".
De este modo ejecutará el lenguaje ensamblador MPASM
en el trasfondo usando las configuraciones guardadas
con el proyecto anteriormente. Una vez completado el
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Tabla 1

list p=16f84
include  <p16F84.inc>

c1 equ h'0c' ; Establece el contador de variable temp c1 en la dirección 0x0c
org h'00' ; Establece la base de memoria del programa en el vector reset 0x00 reset
goto start ; Ir a inicio en el programa principal 

org h'04' ; Establece la base de memoria del programa al comienzo del código del 
; usuario

start
mov1w h'09' ; Inicializa el contador a un valor arbitrario mayor que cero
movwf c1 ; Guarda el valor en la variable temp definida

loop
incfsz c1,F ; Incrementa el contador, ubica los resultados en el registro de archivos
goto loop ; loop hasta que el contador se completa

goto bug ; Cuando el contador se completa, va a start para reiniciar
end
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proceso de ensamble, aparecerá la ventana "Resulta"Resulta--
dos de Constrdos de Construcción (Build Results"ucción (Build Results" (figura 43):

Ha ingresado intencionalmente al menos “un error” si
ingresó el código tal como lo hemos escrito en el paso an-
terior. El último "goto" en el programa refiere a un rótulo
inexistente llamado "bug". Dado que este rótulo no ha si-
do definido previamente, el lenguaje ensamblador infor-
mará el error. También podría relevar otros errores.

Haga un doble click sobre el mensaje de error. De
este modo ubicará el cursor en la línea que contiene el
error en el código fuente. Cambie "bug" por "start". Use la
ventana "Resultados de construcción (Build Results)"
para hacer una búsqueda de errores, y reparar los que
aparecieran en el código fuente. Reensamble el archivo
ejecutando la función de menú "Proyecto>Construir to-
do". Este procedimiento puede demandar un par de re-
peticiones.

Nota: Cuando reconstruya un proyecto, todos sus ar-
chivos fuente serán guardados en el disco.

Luego de reparar todos los problemas en el código
fuente, la ventana "Resultados de construcción" mostrará
el mensaje "Construcción completada exitosamente
(Build completed successfully)". Ya ha completado un
proyecto que puede ejecutarse usando el simulador.

Ejecución de su Programa
Use "Debug>Ejecutar>Reset (Debug>Run>Re-

set)" para iniciar el sistema. El contador del programa se
reseteará a cero, que es el vector de reset en el 16F84.

La línea del código fuente en esta dirección será destaca-
da con una barra oscura. También advertirá que en la ba-
rra de estado, la PC se establecerá en 0x00.

Use el ítem de menú "Debug>Ejecutar>Paso (De-
bug>Run>step)" (figura 44). Al hacerlo, el contador del
programa avanzará hasta la siguiente ubicación de ins-
trucción. La barra oscura seguirá el código fuente y el
contador del programa desplegado en la barra de estado
avanzará hasta "4".

Cuando ejecute el ítem de menú "Debug>Ejecutar-
>Paso", advierta la aparición de un texto en el lado dere-
cho del ítem de menú que dirá "F7". El mismo equivale a
"tecla de función siete" en su teclado. Muchas funciones
del MPLAB se asignan a "teclas-especiales". Estas teclas
cumplen la misma función que los ítems de menú a los
cuales corresponden. Presione F7 varias veces y verá có-
mo el contador del programa y la barra avanzan a través
del programa.

Ejecute el ítem de menú "Debug>Ejecutar>Ejecutar
(Debug>Run>Run)" o presione F9 para inciar la ejecu-
ción del programa desde la la ubicación actual del conta-
dor. Los colores de la barra de estado cambiarán, para in-
dicar que el programa está ejecutando las instrucciones.
Ninguno de los campos de la barra de estado se actuali-
zará mientras el programa esté en ejecución.

Detenga el programa ejecutando el ítem de menú
"Debug>Run>Halt (detener)" o presionando F5. La ba-
rra de estado volverá a su color original, y el contador del
programa y otras informaciones de su estado serán ac-
tualizadas.

Nota: Otra manera de ejecutar funciones es usar la
barra de herramientas ubicada en el margen superior de
la pantalla. Si ubica el cursor sobre los ítems de la barra
de herramientas, podrá ver el nombre de su función en la
barra de estado. El botón de la izquierda es un botón es-
tándar "cambiar barra de herramientas (change tool
bar)" que le permite desplegar las barras de herramien-
tas disponibles. Estas pueden ser personalizadas, como
podrá advertirlo en la sección "Algunas Sugerencias" al fi-
nal de esta guía. En la barra de herramientas de Debug,
la luz verde es equivalente a F9 (Ejecución) y la luz roja
equivale a F5 (Detención).

Hasta aquí, aprendió a instalar el programa y crear un
archivo para “aprender a prog“aprender a progrramar”amar”. Dimos un ejem-
plo de programación y ya sabemos cómo “correr el pro“correr el pro--
ggrrama en la PC”ama en la PC” para saber si todo está bien, antes de
escribir dicho programa en nuestro PIC. Sin embargo,
cuando los programas son más largos, es posible come-
ter errores que pueden ser evitados. A continuación expli-
camos el procedimiento.
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Abrir Otras Ventanas Para 
el Seguimiento de Errores
Hay muchas maneras de visualizar el programa y su

ejecución usando el MPLAB. Por ejemplo, este programa
está destinado a incrementar un contador temporario pe-
ro, ¿cómo puede asegurarse que se está produciendo di-
cho incremento? Una manera es abrir e inspeccionar una
ventana de registro de archivo. Puede hacerlo ejecutando
el ítem de menú "Ventana>registros de archivo (Win-
dow>File Register)". Aparecerá una pequeña ventana
con todos los registros de archivo o el RAM del 16F84.

Presione F7 (ejecute instrucción por instrucción, si
piensa anularlo) varias veces, y observe la actualización
de valores en la ventana de registro de archivo. Hemos
colocado la variable del contador en la ubicación de direc-
ción 0x0C. Mientras el contador temporario se incremen-
te, este incremento se reflejará en la ventana de registro
de archivo. Los registros de archivo cambian de color
cuando su valor cambia, de modo que los cambios pue-
dan advertirse fácilmente en la inspección. De todos mo-
dos, en muchos programas complejos, varios valores
pueden cambiar, así resultará más difícil focalizar las va-
riables que le interesan. Usando una ventana de observa-
ción especial, este problema puede solucionarse.

Ahora, ya sabemos mejor qué es lo que estamos ha-
ciendo:

ProgProgrramamos algo que incrementa en amamos algo que incrementa en “1”“1” cadacada
vvez que viene una señal”ez que viene una señal” y podemos vy podemos verer ificarificar lo virlo vir --
tualmentetualmente, antes de prog, antes de progrramar el PICamar el PIC..

Creación de una Ventana de Observación

Ejecute el ítem de menú "Ventana>Nueva ventana
de observación (Window>New Watch Window)". Apa-
recerá el diálogo "Agregar Símbolo de Observación (Add

Watch Symbol)" (figura 45). Tipee "c1" en la caja de nom-
bre de símbolo para que la lista se despliegue hasta el
símbolo deseado. Selecciónelo, presione el botón "Agre-
gar (Add)", y luego el botón "Cerrar (Close)". Aparece-
rá en su escritorio MPLAB una ventana de observación
que mostrará el valor actual del valor "c1" del contador
temporario.

Presione F7 varias veces para advertir cómo se ac-
tualiza la ventana de observación mientras el valor del
contador se incrementa. Si dejó la ventana de registro de
archivo abierta, la misma también será actualizada (mue-
va una de ellas para que pueda ver las dos en la panta-
lla).

Puede guardar la ventana de observación y sus con-
figuraciones al ejecutar el ítem "Guardar observación
(Save Watch)" debajo del botón del sistema, ubicado en
el ángulo superior izquierdo de la ventana de observa-
ción. Al clicar este botón, se desplegará un menú en cas-
cada. Seleccione "Guardar observación" y aparecerá el
diálogo de exploración estándar ubicado en el directorio
del proyecto. Elija algún nombre arbitrario y presione
"Aceptar (OK)".

Si no nombra la ventana de observación, el MPLAB lo
hará por usted. La ubicación y el estado en la pantalla de
la ventana abierta o cerrada serán guardados con el pro-
yecto, de modo que la próxima vez que abra su proyecto,
sus ventanas de observación aparecerán restauradas.

Nota: También puede editar ventanas de observación
luego de crearlas. Use el botón del sistema y seleccione
"Agregar Observación (Add Watch)" para que aparez-
ca un diálogo mediante el cual podrá agregar más ítems.
Con la tecla "Ins" podrá hacer lo mismo. Si desea borrar
un ítem, selecciónelo y presione la tecla Suprimir (Dele-
te); la observación referida desaparecerá de la ventana.
Puede seleccionar "Editar observación (Edit Watch)"
en el menú del sistema para cambiar el modo en el cual
se muestra el ítem (en hex, binario, como una variable de
16-bit en vez de 8-bit, etc.).

Cómo se Marca un Punto de Interrupción
Presione F5 ("Debug>Ejecutar>Detener") para ase-

gurarse que el procesador del simulador se ha detenido.
Clique dentro de la ventana del código fuente la línea si-
guiente al rótulo "start", que dice "movlw 0'09'". Presione
el botón derecho del mouse para que aparezca el menú
de la figura 46.

Clique el ítem de menú "Punto(s) de interrupción
(Break Point)". El menú desaparecerá y la línea donde
se ubicó el cursor cambiará de color, para indicar que ha
sido establecido un punto de interrupción en dicha ubica-
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ción. Presione F6 o ejecute el ítem de menú "Debug>E-
jecutar>Reset (Debug>Run>Reset)" para resetear el
sistema. Luego, presionando F9, ejecute el sistema. El
programa se ejecutará y se detendrá en la instrucción
ubicada luego del punto de interrupción. "c1", como apa-
rece en la ventana de observación o en la de registro de
archivo, si la tiene aún abierta, reflejará el estado reset de
cero, el modo instrucción por instrucción ejecutará la car-
ga y c1 luego reflejará un valor de 0x09. Presione F9 va-
rias veces y advierta que la barra de estado cambia de
color mientras el programa se esté ejecutando, y luego
retorna a su color original cuando el procesador se detie-
ne.

Algunas Sugerencias:

PUNTOS DE INTERRUPCION - Puede marcar puntos de in-
terrupción en la ventana "Ventanas>Memoria de progra-
ma (Window>Program Memory)", en la ventana de archi-
vo fuente (en este caso tutor84.asm), o en la ventana
"Ventanas>Listado Absoluto (Windows>Absolute)".

ARCHIVOS FUENTE - Use "Ventana>Ventana de Proyec-
to (Window>Projet Window)" para que aparezca una lista
de sus archivos fuente. Puede hacer un doble click sobre
el nombre de un archivo para trasladarlo al editor.

ERRORES MPASM - Si el MPASM le da un error, haga
un doble click sobre el error en la ventana de error para ir
al error en el código fuente. Si tiene múltiples errores,
siempre elija el primer error —generalmente un error cau-
sa errores subsiguientes y al reparar el primero corregirá
los restantes.

CONFIGURACIÓN DE BITS Y EL MODO DEL PROCESADOR -
La configuración de bits en el archivo fuente no determi-
nará el modo del procesador para el simulador (o los
emuladores).

Use "Opciones>Configurar Procesador>Hardware
(Options>Procesor Setup>Hardware)" para estas confi-
guraciones. Aún cuando puede establecer estos bits en
el archivo fuente del MPASM o del MPLAB-C17, el
MPLAB no cambia automáticamente los modos. Por

ejemplo, la configuración de bit Activar Observación de
Dog Timer puede hacerse de tal modo que, cuando pro-
grame un dispositivo, el Dog Timer sea activado. En el
MPLAB también necesitará acceder al diálogo "Opcio-
nes>Configurar Procesador>Hardware" para activar el
WDT para el simulador o el emulador. Esto le permitirá
hacer un seguimiento de errores con el WDT activado o
desactivado sin cambiar su código fuente.

OPCIONES - Use "Opciones>Configurar Entorno (Op-
tions>Enviroment Setup)" para hacer lo siguiente:

* Establecer teclas de Mapa Europeo para funciones
MPLAB y caracteres ASCII especiales

* Cambiar la fuente de la pantalla o el tamaño de la
fuente

* Posicionar la barra de herramientas a un lado o al
pie de la pantalla

* Modificar la barra de herramientas
* Cambiar la cantidad de caracteres desplegados pa-

ra los rótulos.

ARCHIVOS MAPA - Use el diálogo "Proyecto>Editar Pro-
yecto" y cambie las Propiedades del Nodo del MPASM
para producir un archivo MAP llamado tutor84.map. Lue-
go de construir el proyecto, busque el tutor84.map para
ver información de la construcción.

MENUES DESACTIVADOS - Si encuentra menúes desacti-
vados (opacados), verifique que no haya ingresado el mo-
do "sólo Editor (Editor Only)".

Si está seguro de que ha realizado correctamente la
configuración, intente salir del MPLAB y reinicie el progra-
ma.✪
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